
FAstFax 4.2 for WinFax PRO User’s Guide

BONZI SoftWare
396 17th Street
Paso Robles, CA  93446
Fax: 805-238-5798
CompuServe: 72053,2227
Internet: 72053.2227@compuserve.com

Note: There are other versions of FAstFax 4.x available. There's FAstFax 4.0 for MS At Work Fax, along 
with other popular faxing programs.

What is FAstFax?

FAstFax 4.2 is an extremely easy and friendly interface program that allows you to fax 
from Microsoft Word for Windows 6.0 through WinFax PRO, taking full advantage of the
latest WinFax 3.0, 4.0 (and WinFax for Networks) technologies.

You can install FAstFax in minutes, and have your entire company faxing quickly and 
easily through WinFax PRO.

FAstFax allows even the most inexperienced computer users to fax confidently. There's
little or no training, because users only have to remember one keystroke, and FAstFax 
leads them through the rest.

Here's how:

1. FAstFax scans your document, finds the recipient’s name and fax number, and 
(using DDE) automatically passes them over to WinFax PRO—so you no longer 
have to keep TWO separate phonebooks. If you were tired of typing a person’s 
name and fax number TWICE—once on the document and again before you 
faxed—you will love FAstFax.

2. FAstFax shows you a thumbnail page preview of your document—so you’ll always 
fax the correct pages, and be able to check the final look and layout of your fax 
before sending it off.

3. FAstFax automatically sets the fax driver and resets the printer driver for you—so 
you don’t have to think about driver settings again. And no more print jobs 
accidentally sent to the fax modem!

4. FAstFax allows you to "Fax & Print" with one keystroke. For example, it sets your 
fax driver, faxes your document, then re-sets your printer driver, and prints your 
document—all automatically, all with one keystroke.

5. FAstFax allows you to access the WinFax PRO send screen so you can quickly 
select File Attachments, Cover Pages, Phonebook entries, etc. You can even 



use FAstFax to quickly add a person's name and fax number to the WinFax PRO
phonebook without having to re-type it.

6. FAstFax's Date and Time Scheduling features allow you to send your faxes 
immediately or schedule them for later. This is especially useful for taking 
advantage of the cheaper phone rates late at night.

7. FAstFax also gives you a Resolution Choice feature that allows you to send "low 
resolution" or "standard" faxes—yet another way to save on long distance phone
costs. This one is great for faxing internationally—saving you money on every 
fax you deliver before crossing into that costly "second minute."

8. FAstFax's page range settings allow you to easily fax an entire document or just the 
current page—which is great for those quick 1 page faxes.

9. FAstFax also handles all of the following dialing prefixes automatically: Outside line 
access codes (for example "9"), Local area codes, Long distance access codes, 
Local long-distance access codes, and 800 prefix access codes.

10.FAstFax does all this in 2 keystrokes!

1.  Hit Alt-X and ENTER.
2.  Go get a doughnut.

In fact, once you try FAstFax and see how much easier and faster it is, you’ll never 
want to fax the old way again.

Installation and Setup

To setup FAstFax, DOUBLE CLICK the "install button." The FAstFax 
Setup dialog box will appear. You can then pick the default settings of 
your choice, and create your own custom identifiers.

Note: This setup is made to be run again and again, anytime you wish to choose 
different default settings or re-design your own custom identifiers.

Note also: If you decide after trying FAstFax 4.2 that it's not for you, you can easily 
remove it from your system by following the instructions in Appendix A: Un-Installing 
FAstFax 4.2 (at the end of this guide).

This is what the install macro does:
· It copies the FAstFax macro into your NORMAL.DOT template so that it will be 

available globally.
· It assigns the keyboard shortcut key of Alt-X to the FAstFax macro.
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· It adds FAstFax to the menu of your choice.

Important: For FAstFax to install properly, all three files (FASTFAX.DOC, 
FASTFAX.DOT, and FASTFAX.BMP) must be in the same directory (for example C:\
FASTFAX). This is because the installation program looks for FASTFAX.DOT and 
FASTFAX.BMP in the same directory that you open FASTFAX.DOC.

We recommend you create a directory called C:\FASTFAX to store all of the FAstFax 
files. This way you can re-run the Install FAstFax macro any time in the future should 
you decide to change any of the defaults or re-design your own custom identifiers.

Note: If you are already running, or would like to run, different versions of FAstFax 4.x on the same 
computer, this causes no problems. Just be sure to name the directories something different so that the 
files for one version do not get overwritten with the files from another. For example, use C:\FASTAW for 
the At Work version, C:\FASTWFX for the WinFax PRO version, etc.

That's it! Once installed, you can begin using FAstFax immediately. To see how it 
works, skip to the Sample.doc section below.

Important note to WinFax PRO 3.0 Users

WinFax PRO 3.0 users only: You must have updated your version of WinFax PRO 3.0 
with Delrina's latest "patches" to be able to use FAstFax's "Show WinFax Send Screen"
feature.

This feature will not work with releases of WinFax PRO 3.0 dated before May 17, 1993 
because the programming commands used to access this feature only became 
available in the later releases.

To check the release date of your version, hit Help>About from WinFax PRO. If you 
have a version of WinFax PRO 3.0 with a release date before April 21, 1993, get the 
patches WFX304.ZIP and WFX306.ZIP. When you update WinFax PRO using 
WFX304.ZIP, the program release date changes to April 21, 1993. And when you 
update WinFax PRO using WFX306.ZIP, the program release date changes to May 17,
1993.

On CompuServe:

1. Go to the Delrina Forum (GO DELRINA).
2. Download filename "WFX304.ZIP" and "WFX306.ZIP".
3. UnZip these files and follow their "readme" instructions.

Tip: It's a good idea to check the Delrina Forum on CompuServe periodically, as 
Delrina is constantly improving and updating their drivers and .DLL's. If you don't have 
access to CompuServe, you can find these updates on other on-line services, like 
America Online, for example. Or you can order them directly from Delrina.
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Note: You can still run FAstFax 4.2 with releases of WinFax PRO 3.0 dated before May 
17, 1993. It works fine. You just will not be able to use the "Show WinFax Send Screen"
feature.

Sample.doc

To see a demonstration of FAstFax 4.2 in action, we have included a sample mail-
merge "main" document (SAMPLE.DOC) attached to a sample "data source" 
(SAMPDATA.TXT) that contains 5 records.

Note: To better understand merge fields and how they can increase your productivity, see the section 
later in this manual titled "Using PIMs and Contact Manager Software."

But for now, simply open SAMPLE.DOC and hit Alt-X. That's it! FAstFax will 
automatically switch to the fax driver, scan the document to find the recipient’s name 
and fax number, pass them over to WinFax PRO, "rasterize" (create a fax image .dcx 
file for) whichever pages you have selected in the page range settings, allow you to 
select file attachments and cover pages, and finally return you back to Word for 
Windows after resetting your printer driver back to whichever default printer it was on.

Open sample.doc and check it out!

FAstFax Identifiers: “To:” & “Fax:” or Whatever you want!

FAstFax searches for “To:” and “Fax:” (or any custom identifiers you create) to identify 
the recipient’s name and fax number. If FAstFax can’t find a “To:”, it will put you in the 
To: field and wait for you to enter the recipient’s name manually. If FAstFax can’t find a 
“Fax:”, it will put you in the Fax: field and wait for you to enter the fax number manually.

Because FAstFax scans the entire document, the “To:” and “Fax:” information can be 
anywhere in your fax. Normally, they will be on the fax cover page, or if you are faxing a
one page letter, they will be on that. But the nice thing about FAstFax is that they don’t 
have to be. They can be anywhere. And in any order.

For example, they can be on the same line, like this:

To: Woody Allen Fax: 555-555-5555

Or they can be reversed, like this:

Fax: 555-555-5555 To: Woody Allen

Or they can be separated by tabs, like this:

To: Woody Allen
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Fax: 555-555-5555

Or they can have leading text on the same line, like this:

This message To: Woody Allen

Or they can have following text on the same line (as long as there is a tab or at least 
two spaces after the name or fax number), like this:

To: Woody Allen  Date: January 20, 1995

In fact, FAstFax's search routines are so smart, they will even work with everything 
crammed together on one line, like this:

To:Woody AllenFax:555-555-5555

Note: FAstFax always goes to the top of the document and searches down. So if 
you save many faxes in one file, order them the way you file paper files—i.e. the most 
recent first. This way FAstFax will always find the correct “To:” and “Fax:”.

The Big Tip: "Hidden Identifiers"

FAstFax's ability to find "hidden identifiers" gives you complete flexibility in designing 
your faxes to look exactly the way you want, while at the same time allowing FAstFax to
find the recipient's name and fax number accurately. To understand how this works, 
please see the following 3 examples:

Example 1: Hiding the "To:" and/or "Fax:"

If you don't want the “To:” or “Fax:” to show up on your fax, you can make them “hidden
identifiers” by selecting them and choosing Format>Font>Hidden text. FAstFax will still 
find the name and fax number, but the hidden “To:” or “Fax:” won’t show up on your 
fax.

For example, you might want to fax a one page letter containing the recipient’s name, 
address, and fax number—but in this case, you wouldn’t want the word “To:” to show 
up. Simply do it like this:

BONZI SoftWare
396 17th St.
Paso Robles, CA  93446
Fax: 805-238-5798

Dear BONZI SoftWare,

I love FAstFax! Great work! Kudos!
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(Note: there is a hidden “To:” before the name BONZI SoftWare. If you cannot see this,
hit Tools>Options>View>Nonprinting Characters>Hidden Text. Once you see it, and 
know it’s there, go ahead and hit File>Print Preview to see that it doesn’t show up when
you print and/or fax.)

Example 2: Using Separate Cells

If you split “To:” and "Woody Allen" into separate cells, FAstFax has no way of knowing 
they are related.

To: Woody Allen

But not to worry! If you prefer this two-cell method, you can easily make it work with 
hidden identifiers! One method is to custom design a name identifier (into anything 
different than "To:". For example, "To>"). Then simply add that "To>" as a hidden 
identifier. Like this:

To:  Woody Allen

FAstFax will search for "To>" and find Woody Allen!

If you use this method often, we recommend that you store the hidden identifiers "To>" 
and "Fax>" in Word's AutoCorrect (with "formatted text"). Then all you have to do is hit 
"t" space, and AutoCorrect will replace the "t" with the hidden "To>". Then simply type 
the recipient's name like you always do.

Or, here's an even better idea! Just put the hidden identifiers in your fax templates. 
Then, every new fax document you create will already have them typed in.

Example 3: Skipping over YOUR fax number

If you have a header with YOUR fax number in it, you will want FAstFax to skip over 
your fax number and find the recipient’s fax number. You could simply make your fax 
number identifier anything different—like “Fax” or “(Fax)” or “Fax #”, etc. Or, if you want
to use the same identifier for both your fax number and the recipient’s fax number, you 
can simply use a hidden identifier (like "Fax>"). Example:

ABC Widget Co.
1225 Main St., Paso Robles, CA  93446

Phone: (805) 222-2222  Fax: (805) 444-4444

To: So-and-so.
Fax:  555-555-5555

Dear So-and-so,

I love your widgets! Great work! Kudos!
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However, an even better method is to add a hidden space between "Fax" and the ":" in 
your letterhead. FAstFax will then skip over your fax number and find the recipient's fax
number because it is looking for "Fax:" not "Fax(space):". On the screen, your fax 
number identifier will look like this: "Fax :". But that hidden space won't print, so on the 
fax, it will look like this: "Fax:". An example of this method is used in the file 
SAMPLE.DOC.

So you see, with FAstFax 4.2, you have complete flexibility in designing your faxes to 
look exactly the way you want, while at the same time allowing FAstFax to find the 
recipient's name and fax number accurately. And if you prefer, you can even completely
hide the "hidden identifiers" by hitting Tools>Options>View>Hidden Text. This turns off 
the "Show Hidden Text" feature. So you'll never even have to see them on the screen. 
But FAstFax will find them, and pass the necessary information over to WinFax PRO.

Page Range Settings

FAstFax 4.2 gives you the ability to fax specific pages or specific page ranges within a 
document.

To make this process as fast as it can be, FAstFax automatically fills in the page 
numbers for you, depending on which selection you have chosen. For example, when 
you select the page range "All Pages," FAstFax determines the total number of pages 
in your document and automatically fills in the page range for you (ex: Page 1 To 16).

When you select the page range "Current Page," FAstFax automatically fills in the page
number of the current page (for example Page 10 To 10). And, as you move through 
the FAstFax page previewer with the "Next Page" and "Previous Page" buttons, 
FAstFax tells you what page number you are viewing and automatically updates the 
page range for you as you go.

"Sticky" Default Settings

FAstFax 4.2 allows you to set your favorite default settings from within the FAstFax 
program itself. "Sticky" settings are settings that "stick" to whichever selection you 
chose the last time you ran the program. Whenever you change a setting, FAstFax 
remembers were you were so that you will be defaulted to that setting the next time you
run FAstFax.

For example, if you're a person who most often faxes the "Current Page" of your 
documents, simply select that setting one time and FAstFax will always default to that 
choice. Note: This also works with the other features: Hard Copy, Low Resolution, and 
Show WinFax Send Screen.
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"Fax & Print"

Just select FAstFax's "Hard Copy" checkbox, and you'll really start to appreciate the 
automation FAstFax offers.

This feature is for when you need to print a hard copy of the fax—for example for filing 
purposes. FAstFax 4.2 handles this automatically—allowing you to "Fax & Print" with 
one keystroke. Here's how: FAstFax sets your fax driver, "rasterizes" (creates a fax 
image .dcx file for) whichever pages you've selected, faxes your document through 
WinFax PRO, then returns you to Word for Windows 6.0, re-sets your printer driver, 
and prints out a hard copy of your document on your printer.

Cool! Slick! Neat!

Previewing Faxes

One of FAstFax's nicest features is its thumbnail page previewer. Seeing a thumbnail 
sketch of your faxes takes away that uneasy "blind" feeling. You can peruse your 
documents to make sure everything looks right before sending them off, confident and 
secure that the visual presentation your faxes will make will be sharp and professional-
looking.

Plus, the page previewer makes selecting specific pages or page ranges easier. And 
it's very nice knowing, that the pages you faxed someone, were indeed the exact pages
you wanted to fax.

Tip: If you want to see the detailed view of the actual graphical image of your fax, just 
use WinFax PRO's "Preview/Annotate" feature. This is really nice for when you need to 
knock 'em out with a sharp presentation, because you can view EXACTLY what is 
going to print out on the recipient's fax machine before you send it off. Here's how:

1) If “Preview/Annotate” is already set to "on",  just run FAstFax and you'll see the 
actual graphical image of your fax right after you hit the OK button. Zoom in.
Zoom out. Check it out. And then, once you're satisfied it's "perfect," you 
can send it off. Or, you can cancel at this point—which returns you back to 
Word 6.0, where you can make any necessary changes, and then run 
FAstFax again.

2) If “Preview/Annotate” is set to "off," just select the "Show WinFax Send Screen"
checkbox on the FAstFax program screen, hit OK, and select the 
"Preview/Annotate" feature from the WinFax Send Screen. You'll see the actual
graphical image of your fax, and once you're satisfied with the look and layout 
of it, simply send it on its way.

Selecting File Attachments
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If you have certain "attachments" that you fax out to people often, WinFax PRO 3.0, 
4.0, and WinFax PRO for Networks all make it super easy to select any number of them
and send them as faxes. WinFax PRO 4.0 even allows you to attach complete files—so
you no longer have waste lots of time "pre-rasterizing" and organizing them before 
sending them off.

Just check the "Show WinFax Send Screen" feature on the FAstFax program screen, 
and FAstFax will do all it's usual scanning, passing, and rasterizing, etc. But this time, 
FAstFax will take you into the WinFax PRO send dialog box and wait for you to select 
any additional files you would like to include with the fax.

Most companies design a professional-looking fax cover page in Word for Windows 6.0
—usually including their letterhead and logo. Then, when they need to fax some 
specific documents, they quickly fill out the cover page, type a short message 
describing the contents, and send it off with the attached documents. FAstFax makes 
this process quick and easy:

1. Hit Alt-X and Enter
2. Attach the documents
3. Hit "Send"

That's it! In a matter of seconds, the recipient will receive a professional cover page 
with one, two, three, or more attached documents.

Accessing the WinFax PRO Phonebook

You don't have to use FAstFax's searching and dynamic data exchange features every 
time. For example, let's say you want to quickly send someone a file without a cover 
page, or you want to get their name and fax number from the WinFax Phonebook 
rather than off the fax itself. Well, FAstFax 4.2 allows you to access the WinFax 
phonebook—which means you can use FAstFax like any other "driver-switching" macro
that takes you straight to the WinFax send screen and allows you to find the person in 
your phonebook. Just hit Alt-X and Enter, select the recipient in the phonebook, and hit 
"Send." That's it!

And when you do use FAstFax's searching and dynamic data exchange features, note 
you can add a person's name and fax number to the WinFax PRO phonebook without 
ever having to re-type it. Just run FAstFax with the "Show WinFax Send Screen" on 
and hit the "Add to phonebook" button. That's it! The name and number are 
automatically entered into your WinFax Phonebook.

Date and Time Scheduling
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FAstFax allows you to send your faxes immediately or schedule them for a later date 
and time. Just choose the "Scheduled" feature on the FAstFax program screen. This is 
especially useful for taking advantage of the cheaper phone rates late at night.

Many people love this feature, not so much for saving money by faxing late at night, but
rather because it allows them to batch their faxes all at one time. If you usually sit there 
waiting for one fax to be sent before you start working on the next one, just start 
scheduling your faxes to be sent at some later time. FAstFax will queue up all your 
faxes in WinFax PRO's event list and let you get immediately back to work. Then, after 
you have written and queued up the last fax in the batch, you can call up WinFax PRO, 
highlight all the faxes, hit the "Reschedule" button, and fax them all off immediately. 
With this method, you can prepare a half dozen different faxes and then walk away 
from the computer while they are all being sent.

When you schedule, remember that WinFax PRO only accepts date and time in the 
following formats: Date: MM/DD/YY. Time: HH:MM:SS. This is not hard to remember, 
as FAstFax displays the correct formats for you in the date and time fields. Notice, too, 
that FAstFax always defaults to today's date at 11:00pm that night. This is because the 
lowest phone rates occur in most places between 11:00pm - 8:00am.

Important Note to Intel CAS software users: When scheduling faxes, be aware that an incompatibility 
appears to exist between WinFax PRO and Intel CAS software. If you schedule a fax for a later date or 
time, and then delete the pending fax from the WinFax Event List or the WinFax OutBox, the .DCX file 
that the Intel CAS software creates is NOT deleted by either Delrina or Intel. So you must go to the 
directory in which the .DCX file is stored (usually c:\winfax\data) and delete it manually. If you forget to do
this, and you have scheduled the fax to go at a certain time, we've experienced that the CAS software will
send it out (even though it was deleted from the WinFax Event List/OutBox).

Dialing Prefixes

FAstFax handles all of the following dialing prefixes automatically:

· Outside line access codes (for example "9")
· Local area codes
· Long distance access codes
· Local long-distance access codes
· 800 prefix access codes

You'll appreciate how FAstFax adds the necessary prefixes and access codes to your 
fax numbers so you don't have to worry about them or waste time adding them by 
hand.

Outside line access codes

If you need to dial a prefix to get an outside line (for example "9"), FAstFax will 
automatically add this prefix before each fax number. You can also include commas for 
necessary delays (each comma = 2 second delay).
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Note: FAstFax will ALWAYS add the default dialing prefix to EVERY fax number. If you don't use a 
default dialing prefix, leave this option blank in the FAstFax setup.

Local area code

FAstFax automatically recognizes your local area code and avoids dialing it. If you 
travel, move, or your local area code changes for any other reason, simply enter your 
new area code in the FAstFax installation program, and FAstFax will take care of the 
rest.

Note: The following dialing prefixes (Local area code, Long distance access code, Local long-distance 
access codes, and 800 prefix access code) may not work in some countries because of non-standard 
number lengths. FAstFax looks for 7 digit numbers (for example 238-5798) and 10 digit numbers (for 
example 805-238-5798) to determine when local and long distance access codes need to be added.

FAstFax only tests numbers that are 7 or 10 digits long, ignoring all others. To do this, it first strips out all 
"non-number" characters and symbols, then re-formats the numbers into the North American standard 
(i.e. 3 digit area code followed by 7 digit number), adding the dashes "-" in between them.

In other words, FAstFax must assume that a 7 or 10 digit number falls into the North American standard. 
If you live in Europe, or you dial many 7 and 10 digit numbers that do not fall into the North American 
standard (i.e. 3 digit area code followed by 7 digit number), you can leave the local area code blank in 
your FAstFax setup to prevent FAstFax from testing and re-formatting your 7 and 10 digit numbers. Then
see "Not supported: International access and local country codes" below to learn how to set the default 
cursor location in the "fax number field" so you can quickly enter any necessary numbers before faxing.

Long distance access code

FAstFax will add a long distance dialing prefix to numbers outside of your local area 
code (usually a "1"). Note: The telephone companies are now in the process of 
eliminating these long distance access codes. When this change occurs in your area, 
simply re-run the FAstFax installation program and remove the long distance prefix.

Local long-distance access codes

FAstFax will add a dialing prefix to numbers WITHIN your local area code that require a
long distance access code (usually "1"). Sometimes referred to as "toll calls," FAstFax 
automatically handles all of these local long distance numbers. Note: The telephone 
companies are in the process of eliminating these codes, also.

800 prefix access code

FAstFax will also automatically add the dialing prefix required for 800 numbers (usually 
"1").

Not supported: International access and local country codes

Note: International access codes and local country codes are not supported by FAstFax
at this time. However, these codes can be handled by using either of the following two 
methods:
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1) Add them to the number on the fax. For example:

 Fax: 011-805-238-5798

If you don't like the "011" to show up on your fax, here's a tip: Just as hidden text works
nicely for hidden identifiers, the same principle can be applied to numbers, or even text,
that you need to pass to WinFax PRO, but that you don't want to show up on the fax. 
For example:

 Fax: 805-238-5798

You won't see the international code "011" on the fax, but FAstFax will find it, enter it in 
the fax number field, and pass it over to WinFax PRO for dialing. (Note: You can even 
include comma delays if needed.)

2) Simply add them by hand in the FAstFax program's fax number field prior to faxing. 
To speed this even further, we've built in the ability to set the default cursor location in 
the "fax number field" so you can quickly enter any necessary numbers and be on your 
way. To setup this feature, simply re-run the FAstFax installation program and choose 
the "fax number field" as your default cursor location. Then, for example, faxing 
internationally will be as easy as hitting Alt-X, 011, and Enter.

Suggestions

Loading WinFax PRO

The most efficient way to use WinFax PRO and FAstFax is to have WinFax PRO 
already loaded, because this way, when you run FAstFax, it will pop right up. But even 
if WinFax PRO is not already loaded, it's no big deal. It only adds one more keystroke.

When you run FAstFax without WinFax PRO already loaded, the following message 
appears: “The remote data (TRANSMIT) is not accessible. Do you want to start the 
application FAXMNG?” FAXMNG is the main WinFax PRO program (it stands for “Fax 
Manager”). This message is Delrina's way of saying, "Do you want to load WinFax 
PRO?" So simply hit "Yes"—it will quickly load WinFax PRO—and FAstFax will take it 
from there.

Note: If you get an error when answering "yes" to "Do you want to start the application 
FAXMNG?", it usually means that the directory in which you installed WinFax PRO 
(usually C:\WINFAX) is not in your path statement in your autoexec.bat file. For WinFax
PRO to function properly with DDE, WinFax must be either in your path statement or 
running when the DDE is initiated.

Assigning FAstFax to a toolbar button
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If you’re a toolbar person, assign FAstFax to a toolbar button. The only reason we 
didn’t automatically install it on your toolbar is because monitors that run 640x480 don’t 
have any more room to add toolbar buttons.

There is no FAstFax icon. But you can choose any of the custom buttons that come 
with Word 6.0. Just click tools>customize>toolbars>macros and drag and drop the 
FAstFax macro to your toolbar. Then choose one of the custom buttons, or create a 
"Text Button," which will say FAstFax.

Upgrade from WinFax Lite to WinFax PRO 3.0, 4.0 (or WinFax PRO for 
Networks)

FAstFax does not work with Delrina's WinFax Lite because WinFax Lite does not 
support DDE like WinFax PRO 3.0, 4.0 (and WinFax PRO for Networks) does. 
Therefore, with WinFax Lite, FAstFax has nothing to "pass" the information to. If Delrina
ever upgrades WinFax Lite to include DDE support, then FAstFax should work with it 
also. But until they do, only WinFax PRO 3.0, 4.0, and Networks users can take 
advantage of FAstFax's dynamic data exchange.

Print out this FAstFax 4.2 User's Guide

We've put everything we could think of into this FAstFax 4.2 User's Guide. All of the 
most common questions and answers, problems and solutions, tips and tricks, etc. You 
might find this manual easier to read and refer to in printed form. Or, speaking of tips, 
here's another one: Whenever you need to refer back to something you've read in this 
manual, the quickest way is to use Word's edit-find command (Alt-E-F) to search for 
information regarding your question.

Using PIMs and Contact Manager Software

The greatest benefit of FAstFax 4.2 is this: once you've entered a person's contact 
information into your database ONE TIME, you will never have to re-type it again.

You can now keep all of your names and fax numbers in a PIM, Contact Manager, or 
even the Word 6.0 database—and once entered, you will never have to re-type a 
person's name and fax number again, either in the WinFax phonebook, or on the fax 
itself. (Even PIMs and Contact Manager software that integrate with the WinFax 
Phonebook cannot give you this because you'll still find yourself having to type the 
person's name and fax number on every fax.)

With FAstFax, you can take advantage of Word 6.0's merge fields to automatically fill in
the information for you. Simply place the identifier "To:" before the <<Full Name>> field,
place "Fax:" before the <<Fax Number>> field, and when you press the "view merged 
data" button, you'll see the merge fields filled in with the recipient's name and fax 
number. Then, you just hit Alt-X to FAstFax the puppy away!
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Note: We have included a sample mail-merge "main" document (SAMPLE.DOC) 
attached to a sample "data source" (SAMPDATA.TXT) that contains 5 records. To see 
a demonstration of how all this works, open sample.doc.

Note: If you've never used Word 6.0's mail merge, it's a piece of cake learning how to set up a mail 
merge "main" document and attach a data source to it. All this information is explained clearly in chapter 
29 of the Word for Windows 6.0 User's Guide: "Mail Merge: Step by Step." Don't be intimidated. Word for
Windows 6.0 has the simplest mail merge setup we've ever seen. You'll be up and rolling in no time.

PIMs like ECCO Professional and Lotus Organizer have "export" features that allow 
you to export just one data record to a comma field delimited text file. When that text 
file is chosen as the "data source" for any Word mail-merge document you create, you'll
see all the information automatically filled in. Even for faxing just one person, this 
merge trick is the greatest thing going because it will fill in all the information for you.

Here's how it works. We use a PIM called ECCO Professional that contains all our 
communications information (phone, faxes, letters, e-mail). With this system, we only 
have to type in a person's information ONE TIME. Then, after that, it's a piece of cake 
communicating with them via fax, letter, e-mail, etc.

Here's how to do it: Simply create "Windows Recorder" macros that will repeat the 
following two steps: 1)  From ECCO Professional (or Lotus Organizer, etc.) export the 
person's name field, fax number field, CompuServe address field, etc. to a comma field 
delimited text file, and 2) In Word, open one of your Word for Windows mail-merge 
templates (We have different ones depending on what kind of communication it is: Fax 
to Business address, Fax to Home address, Letter to Business address, Letter to Home
address, New e-mail, E-mail reply, etc.).

That's it! Now each new document you open will have all the person's information 
already filled in! Name, address, fax number, etc.—it's all right there.

For example, to fax someone at their work address, we simply hit our "Fax to Business 
Address" macro, and 2 seconds later we are over in Word for Windows—needing only 
to type the body of the letter. Everything else is automatically filled in: Our letterhead, 
the date, the recipient's name, the recipient's address, the recipient's fax number, the 
hidden identifier "To:" before the recipient's name, the "Fax:" before the recipient's fax 
number, and even the scanned signature down at the bottom of the page.

All you have to do is type the body of the letter and hit Alt-X to FAstFax that puppy 
away! The whole process has three steps:

1. Alt-1
2. Type body of letter
3. Alt-X

You can't get much more automated than that.

Even if you use a PIM that cannot export a single record, you could periodically export 
your entire database to a comma field delimited text file, and designate that merge file 
as the data source for all your fax templates. Then, when you open a new file, simply 
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use Word's database features (i.e. the binocular button) to find the person's record, and
within a few seconds, you will have a merge document that contains all the information 
needed: name, address, fax number, and any other data you choose—all of it already 
filled in!

We've had people tell us that the value of this information alone was worth registering 
for FAstFax. Which leads us to...

Registration

To receive a permanent license for FAstFax 4.2, open the file REGISTER.DOC and E-
mail, Fax, or Mail the registration form to:

BONZI SoftWare
396 17th Street
Paso Robles, CA  93446
Fax: 805-238-5798
CompuServe: 72053,2227
Internet: 72053.2227@compuserve.com

This version of FAstFax 4.2 is distributed as shareware. Unregistered evaluation copies
can be shared and distributed freely. However, you may not share the registration key, 
which is supplied to licensed users only. If you choose to continue using the program 
and register, that registration key may be used only by the licensee specified in the 
original order for the license. Licenses are not transferable and may not be modified.

a) SINGLE LICENSE for the use of FAstFax 4.2: $29
A single license permits you to use one copy of the FAstFax software on a single 
computer.

b) SITE LICENSE for the use of FAstFax 4.2:
A site license permits you to use FAstFax on as many computers as you have 
licenses. Site license pricing is as follows:

2 to 9 computers $19 each
10 to 24 computers $15 each
25 to 49 computers $13 each
50 to 99 computers $10 each

100 to 199 computers $8 each
200 to 500 computers $6 each

We will send you a personal registration number that will end the trial period and turn 
your evaluation copy into a licensed version.

We will notify you immediately of future updates (free to licensed users), and you will 
also receive special offers on future releases.
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For quick response, register via Fax or E-mail.

MergeFax 2.0

Also, let us know if our other product MergeFax 2.0 sounds like something you might 
be interested in. MergeFax 2.0 is a powerful new program that allows you to mail-
merge group fax hundreds of PERSONALIZED faxes with Word for Windows 6.0 and 
WinFax PRO 3.0, 4.0 (and WinFax PRO for Networks)—all with one simple keystroke.

You can now "touch" all of your customers at the stroke of a key, sending the latest 
pricing information, special offers, "Thank you" replies, and new product information. Or
send customized graphs, charts, letters, and up-to-date sales information to all your 
sales agents in the field. Imagine this power in your company.

MergeFax is one of those rare programs that will save you and your employees hours 
of time. Plus, the date and time scheduling features alone will save you big bucks by 
allowing you to schedule your high volume group faxes late at night when the rates are 
dirt cheap.

Before the creation of MergeFax, the best you could do was "group fax" the same 
document to everyone. Ex: "Dear Customer, thank you for your interest in Ski Chalet 
products."

The power of MergeFax is that it allows you to use Word for Windows 6.0's awesome 
mail-merge features to group fax hundreds of faxes that are PERSONALIZED to each 
individual. Ex: "Dear Jim, thank you for your interest in our winter ski product line." 
"Dear Joe, thank you for your interest in our arrow ski downhill racers." Etc.

MergeFax-ing is as simple as these 2 steps:
1. Set up your mail-merge main document.
2. Hit Alt-M and START.

Here’s how it works:

1) MergeFax automatically merges each data record, scans the document to find the 
recipient’s name and fax number, and then (using DDE) passes this information 
over to WinFax PRO.

2) MergeFax queues up all the faxes in WinFax PRO's event list—either to be sent 
immediately or scheduled for a later date and time.

3) MergeFax automatically sets the fax driver and resets the printer driver for you—so
you don’t have to fiddle with driver settings. You just hit Alt-M and Start, and 
MergeFax takes care of everything else.
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4) MergeFax does all this in minutes! On a 486-66 machine, MergeFax queues up 
WinFax PRO's event list with 100 faxes in 5 minutes!

Appendix A: Un-Installing FAstFax 4.2

If you decide after trying FAstFax 4.2 that it's not for you, you can easily remove it from 
your system. Here's how:

1. Delete the [FAstFax] section from your WIN.INI file.

2. Delete all of the FAstFax 4.2 files that came in the self-extracting package: 
FASTFA.EXE, FASTFAX.DOC, FASTFAX.DOT, FASTFAX.BMP, 
REGISTER.DOC, VENDOR.TXT, FILE_ID.DIZ, README.1ST, SAMPLE.DOC, 
and SAMPDATA.TXT.

3. Delete the FAstFax macro from your normal.dot (global) template by hitting 
Tools>Macro>Delete. When you delete the macro, Word 6.0 will automatically 
remove it from the menu it is installed on, and free up it's Alt-X shortcut key.

4. Delete the file FASTFAX.BMP from your Windows directory.

Thank you for trying FAstFax 4.2!

* * * * * * * * * * End of FAstFax User’s Guide * * * * * * * * * *

17



* * * * * License Agreement * * * * *

You are encouraged to use this program for 15 faxes prior to obtaining a permanent license. You may 
share the FAstFax files with anyone you choose as long as you do not change them. You may not share 
the registration key, which is supplied to licensed users only. If you choose to continue using the program
and register, that registration key may be used only by the licensee specified in the original order for the 
license. Licenses are not transferable and may not be modified. A single License permits you to use one 
copy of the FAstFax software on any single computer, provided the FAstFax software is in use on only 
one computer at any time. If you have multiple Licenses for FAstFax, then at any time you may have as 
many copies of FAstFax in use as you have Licenses.

It is your responsibility to determine if the program will work reliably on your equipment and for your 
particular business environment. BONZI SOFTWARE DISCLAIMS ALL WARRANTIES RELATING TO 
THIS SOFTWARE, WHETHER EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO ANY 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, 
AND ALL SUCH WARRANTIES ARE EXPRESSLY AND SPECIFICALLY DISCLAIMED. NEITHER 
BONZI SOFTWARE NOR ANYONE ELSE WHO HAS BEEN INVOLVED IN THE CREATION, 
PRODUCTION, OR DELIVERY OF THIS SOFTWARE SHALL BE LIABLE FOR ANY INDIRECT, 
CONSEQUENTIAL, OR INCIDENTAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE 
SUCH SOFTWARE EVEN IF BONZI SOFTWARE HAS BEEN ADVISED OF THE POSSIBILITY OF 
SUCH DAMAGES OR CLAIMS. IN NO EVENT SHALL BONZI SOFTWARE'S LIABILITY FOR ANY 
DAMAGES EVER EXCEED THE PRICE PAID FOR THE LICENSE TO USE THE SOFTWARE, 
REGARDLESS OF THE FORM OF CLAIM. THE PERSON USING THE SOFTWARE BEARS ALL 
RISKS AS TO THE QUALITY AND PERFORMANCE OF THE SOFTWARE. Some states do not allow 
the exclusion of the limit of liability for consequential or incidental damages, so the above limitation may 
not apply to you.

This agreement shall be governed by the laws of the State of California and shall inure to the benefit of 
BONZI SoftWare and any successors, administrators, heirs and assigns. Any action or proceeding 
brought by either party against the other arising out of or related to this agreement shall be brought only 
in a STATE or FEDERAL COURT of competent jurisdiction located in San Luis Obispo County, 
California. The parties hereby consent to in personam jurisdiction of said courts.

* * * * * Acknowlegements - Trademarks * * * * *
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